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Definitions 

We’ve published a Test Generator Definitions page for your review.  If you have questions, or 

simply need a refresher regarding some of the elements, please visit this page, or contact us. 

 
Prerequisites Checklist 

Whether you are new to Test Generator or a seasoned TG user, we thought we’d err on the 

side of “just maybe you haven’t seen this tutorial before.”  Excuse the checklist if you’ve been 

there, done that.  

• Your TG testing system is installed and operational  

• Test Generator is installed on your computer and you can login 

• Participated in one or more online, Test Generator training sessions.   

Also, you... 

• Have created one or multiple Courses (Classes) in TG 

• Have created, saved and published one or more tests under one or more courses 

• Have enrolled t.takers into your course and they have taken one or more of your tests 

• Are familiar with TG Reports and the various report settings 

 

Versions and Screen Displays 

This document displays screens and content found in TG2.4.20.   

Depending on which version of TG you happen to be using, the layout and information 

described in your copy of TG may vary from the information presented in this document. 

 
 
Support 

Contact us or email support@testshop.com. 
  

  

https://www.testshop.com/test-generator-product-definitions
https://www.testshop.com/contact/
https://www.testshop.com/reports
https://www.testshop.com/contact/
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Introduction 

To help ensure that your TG experience is a positive and productive one, we’ve assembled a list 

of best practices for your review.  We may have already shared some of this information with 

you during an online demo or through email/phone exchanges, if so, we apologize for repeating 

ourselves. 

 

Audience 

New customers or customer team members who are new to Test Generator—we recommend 

reviewing the entire document.  Intermediate to advanced users may wish to scan the document 

and use it as a general reference, referring to it as needed. 

 

Assumptions and Prerequisites 

TG Desktop customers 

. You have successfully downloaded and installed TG on your computer 

. You have applied the product key that was sent to you 

. You can log in to TG and view TG's home page. 

 

You have reviewed the following tutorials located on the Tutorials page: 

. Welcome to Test Generator 

. TG Introduction 

. TG Basics 

 

TG LAN and TG Web customers 

. Prior to your purchase, you participated in an online demo. 

. You have downloaded the demo recording and  

. Have reviewed it and/or shared it with other members of your team 

. You, or IT, have successfully downloaded, installed and configured your TG testing system 

. You have a TG client installed on your (windows) computer. 

. You can log in to TG and view the home page. 

. Your TG admin client is accessing the database on the server. 

 

Training 

Your purchase of Test Generator includes one or more online training credit hours, depending 

on which product you purchased: TG Desktop (1hr), TG LAN (1-2hrs) and TG Web (2hrs). 

 

Training sessions are recorded, and we email you both streaming and download links.  You can 

replay the sessions as well as share them with other members of your team.   

 

We recommend downloading the sessions to your computer (or server).  These recordings will 

be removed from our servers within 15 days of the date of your online training session.   

  

https://www.testshop.com/tutorials
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Training continued 

 

Best Practice 

We encourage your exploration of TG and its various features.  However, before you dive in and 

start creating question banks and lots of test content, we recommend scheduling your first on-

line training session.  These sessions will accelerate your mastery of the program and help you 

build an organized and efficient testing system in less time. 

 

The first training session covers TG basics.  For customers transitioning from paper-based 

testing to web-based testing, the choice of options can be daunting.  The important thing to 

remember: master the basics first and allow your subject-matter experts and/or peer t.admin to 

evaluate your test content before you make it available to your testing audience. 

 

After the first one-hour training session, we suggest waiting 2 to 3 weeks before scheduling the 

second training session.  The second hour is usually devoted to more Q&A based on your 

experience working with TG.  We are also available to help you determine which TG features 

are best suited to your testing policies.   

 

Best Practice  

Review the TG Help topic, Tests > Test Authoring: Tests: Review Before You Publish 

The most recent TG Help is available online and can also be launched from TG’s Help text 

menu. 

 

Training Dates/Times 

Training sessions are conducted from Arizona  

. spring/summer: UTC -8 hours to fall / winter: UTC -7 hours 

 

Training sessions are scheduled weekly, Tuesdays through Thursdays:  

. Canada/United States: any time after 8am Pacific time.   

. Europe: after 3pm UTC or UTC +1 (summer) 

. Africa: after 4pm UTC or UTC +2 

. Asia/East Asia: custom scheduling due to the 12+ to 15-hour time difference 

. Australia/Pacific: custom scheduling due to the 16 to 17.5-hour time difference 

 

Please suggest two dates/times: we will confirm one of them and email you an invitation. 

  

http://www.helpconsole.com/TGHelp/Static/default.htm
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 Joining a Training Session 

. As of this version of TG Best Practices, we are using GoToMeeting and GoToWebinar. 

. GoToWebinar Customer Support can also be found here. 

 

 

Support 

 

In most cases your TG purchase includes a support subscription. 

Support includes expedited email, phone and online support + free 2.4.## updates.   

Support hours are Monday thru Friday, 8am to 6pm Eastern except weekends and federal 

holidays.   

 

TG Desktop, TG LAN_msa and _sql Plus 

. 1-yr support subscription included: after the first year, support is optional but highly 

recommended. 

 

TG Web Subscriptions 

. Support is included in the cost of your subscription. 

 

TG Web Direct Purchase 

. TG Web DP accounts that are hosted by us include expedited email, phone, online support 

and updates to the latest TG2.4.# release. 

 

. TG Web DP accounts that are hosted by the customer include a 1-yr support subscription.  

Support subscriptions renewed yearly beginning year 2.  Contact us for details. 

 

TG LAN_msa Basic 

. Email support is included--support subscriptions are available for purchase.  

 

 

  

https://support.logmeininc.com/gotomeeting
https://www.testshop.com/contact
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General Information 

 

Version # and TG Release Information 

Update / Upgrade History   

 

Product Key 

Your product key information is located under TG's System module.  The key has two parts, an 

Organization field and a Key field.   

 

 
 

Note: Unless we host your TG Web account, the product key is usually sent to whomever we 

have listed as the technical or training point-of-contact.  

 

TG LAN and TG Web customers can apply the product key on any TG client that is connected 

to the testing system's database—the key only needs to be applied once. 

 

To check if the product key has been applied: 

. Open TG and select the System module in the tree view in the left column. 

. Expand the System module and select the Settings sub-module 

. This will display System Settings information on the right under the General tab 

. If the organization key reads "TG Demo…" the product key has not been applied.   

 

  

https://www.testshop.com/tgupdateshistory
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Also check the "Database Settings" on the page -- under the "DB Location:" parameter, the path 

listed should be pointing to the TG database on your server.   

 

 

 

If it is not pointing to that database, you are not accessing the TG data on your server. 

 

. Contact your technical support person and have them "point" your TG client to the appropriate 

database using the instructions we provided in an email following your purchase or contact 

support@testshop.com if you need assistance. 

 

Security  

The product key should be kept in a safe place.  Once applied, you should not attempt to 

modify it—doing so will cause the TG client to quit working.  The "Expires" and "User Limit:" 

information will indicate if you have a permanent product key, or a subscription. 

 

Subscriptions 

If you have a TG Web subscription, the "Expires:" field will display the expiration date.  This date 

is the date your TG product will "go dark" and cease to work.  You, or the designated POC we 

have on file, will receive renewal notices approximately every 60 to 30 days.  Please contact us 

to renew your subscription, or email support@testshop.com. 

 

TG Help 

We do not provide training manuals or printed documentation—it’s about saving trees and you, 

money.  We do provide an electronic version of TG Help that is included with your installation.   

Online TG Help can be accessed from TG’s Help menu. 

  

  

mailto:contact%20us
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We also provide various instructional materials to include: PDF, PowerPoint and video tutorials.   

In addition, and unless otherwise specified, your purchase includes online training-credit hours.   

Online training sessions are recorded: playback and download links are emailed to you. 

 

In addition to the help resources described above, customers with active support subscriptions 

can contact us for personalized assistance.  

 

 

TG Newsletters and Email Blasts 

Newsletters 

Product newsletters are emailed to the individuals we have on file for your account.  If that 

changes, please email us with the following information: 

* first name:             

* last name:             

* title:          

* email:        

* phone:      

* comments/notes 

 

Newsletter content may include: FAQ's, Case Studies, TG update notices, new or updated 

Tutorials and How-To's.  To make sure you are added to our newsletter list, please contact us. 

 

Email Blasts 

. Periodically, you may receive announcements ranging from product updates to Holiday 

support hours. 

 

 

Test Generator Introduction and Basics 

In case you’re new to TG, the following links will help you become more familiar with the 

program: 

 

* Introduction 

 

* The Basics 

  

https://www.testshop.com/contact
https://www.testshop.com/contact
https://www.testshop.com/tutorials
https://www.testshop.com/tutorials
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* Online TG Help 

You’ll find various help topics under TG Help’s tree view. 

 

 
 

 
  

http://www.helpconsole.com/TGHelp/Static/default.htm
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After the Basics, What’s Next…   
 

Once you’re comfortable with the basics, we recommend reviewing the online recording of your 

first training session.  Another good resource is the TG Help topic, "Question Banks" and the 

related sub-topics—recommended reading.  

 

Question banking may not be for everyone; its use is optional, but HIGHLY recommended.   

It will enable you to streamline your test creation process and take advantage of certain features 

and reports that are only available if you use question banks. 

 

Question banks should be thought of as containers for "known, good questions".  Therefore, it's 

important to review the items in your question banks: check for spelling, grammar, technical 

accuracy and clarity.  Creating a good test item is both a science and an art.  If you need help, 

there are many excellent resources available on the internet.   

 

Adding Items 

You can use any of the following methods to add items to your question banks.  You can: 

1- Create items manually by typing in your question and answer text  

2- Cut-and-paste text from an existing electronic file, ideally a text-only file 

3- Import items from a TG-friendly .csv, .txt or .xls (excel) file. 

4- Import items from a TG-friendly .rtf file 

5- Import items from a TG-friendly .xml file  

 

Once your question banks have been populated with your test items, you can: 

6- Create a new test template and then import one or multiple questions selected from one or 

multiple question banks, or  

 

7- Use the Test Wizard to select one or multiple question banks and then select—and randomly 

import—a subset (number) of questions from each bank.  Once imported into your new test you 

can: 

. Keep all of the imported items, or… 

. Keep some and delete others 

. Import new items from one or multiple question banks or 

. Use methods 1 through 5 to create new items—not recommended if qbanks are being used 

 

You can also create one or more courses and one or multiple tests that can be saved under 

these courses without ever creating a single question bank.  However, we do not recommend 

this approach. 
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Standardizing Fonts 

In using methods 1 through 5, you may end up with items in different fonts and font sizes.  

Before you start exporting items from your questions banks into tests, we recommend 

standardizing your fonts at the question bank level.  Standardizing Fonts Tutorial. 

 

 

Test Creation and Review:  

Best Practice: Review Before You Publish 

 

Assumptions 

. You have created one or several question banks 

. You have reviewed the content, made as-needed changes / corrections and are confident that 

your    

   items are "good" (accurate, clear / concise, spell-checked and grammatically correct). 

. You are prepared to use this content in the creation of tests 

 

Master Course and Tests 

Ideally, we recommend creating a "master" or “sandbox-type” course -- name it whatever you 

wish.  The tests in this course should only be accessible by you and designated evaluators that 

are enrolled in the course--not your test-taking audience. 

 

Create, save, activate your test and invite peer evaluators to take the test.  By “peer evaluators” 

we mean any subject-matter expert or fellow t.authors / t.admins – including you. 

 

Note: TG Desktop and TG LAN evaluators would log in to take a test using the windows Tester.  

TG Web evaluators would log in using the web Tester. 

 

Option: If your TG LAN or TG Web evaluators also have a TG admin client—and assuming you 

grant them permission to access your test—they can open the test (in TG) and evaluate the 

content there as well.  We strongly encourage evaluators to log in to the Tester and experience 

the test as their test-taking audience will experience it. 

 

Based on the peer-evaluator assessment of the test, make any necessary changes / corrections 

to the content -- ideally, these changes will be made in the questions banks not at the test level 

-- your options include: 

 

1- Open your original test and delete the "bad" items and re-import the revised items from the 

question banks from which they were originally imported.  

  

https://www.testshop.com/test-generator-guide-to-standardizing-fonts
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2- Open your original test and select the first cell (*) in the first column to highlight the entire 

table, then press the Delete key on your keyboard (or the red "X" in the icon toolbar) to delete all 

the items in the test.  Then, re-import your questions from the question banks you had selected 

when you created the original test.  This assumes that you have revised the bad items before 

re-importing them into your test. 

 

3- Delete your old test and create a completely new test--importing items from selected question 

banks. 

 

Once your evaluation is complete and you are ready to publish your test, open and save it (File 

> Save As) into a "production" Course.  A course that contains active tests and enrolled / eligible 

t.takers, is also referred to as a production course.  

 

 
Bad Test Items Encountered After Your Test Has Been Published and Taken  
 
If, even after having evaluated and published your test, you encounter one or more bad test 

items--don't panic and please, do not edit your test by changing: 

• A bad item’s answer—e.g., changing the correct answer from B to D, or 

• Adding or deleting questions or answers, or  

• Changing the randomization settings, or 

• Pass / Fail percentage  

 

IF you have  

• Published your test and  

• Had people take the test and  

• Then made any of the changes described above and 

• Then continued to allow people to take the modified test… 

 

…any of these actions would corrupt your test data.  Some TGReports may fail to display 

results and instead display a “corrupt data” message. 

 

Other changes such as spelling, or grammar can be made without corrupting your test data.  If 

in doubt, we encourage you to contact us. 

 

Corrupt Data Scenario 

You created and published a test and enrolled 100 t.takers.  Fifty of these t.takers took the test 

and you then discovered that question #10 was incorrect.  You had marked “A” as the correct 

answer but discovered that the correct answer was “C”.   
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You paused the test, logged in to TG, opened it and changed the correct answer from “A” to “C”.  

You saved the change and then continued to make the test available.  50 new t.takers then 

logged in and took the modified test—the one containing the corrected question #10. 

 

At this stage you have two sets of data: 

Set_1 consists of the 50 people who took the test when question #10’s correct answer was “A” 

and Set_2 consists of the 50 people who took the corrected question #10, correct answer “C”. 

 

Because of the change described above, Set_1 and Set_2 test data no longer match.  We 

would consider this data “corrupt” and any analysis preformed on this data, unreliable. 

 

 
 

Rescoring Your Test After Finding a Bad Item \ 
 
Best Practice Scenario_1 

You have published your test, we’ll call it test_1.  Some, or all, of your testing audience has 

taken test_1.  You then discover that you have one or a “few” bad items.  We recommend: 

 

a- Opening TG and checking to make sure that no one is taking the test.  Locate and expand 

the System module.  Then click on the Locks module to display the Locks table on the right.  

If any member of your testing audience is currently taking test_1, don’t attempt to open it 

until the test session has been completed. 

 

b- If you discover that no one is currently taking test_1, open it (in edit mode) and select the 

Test Settings > Test Properties window.  Click on the Schedule tab.  De-activate the test by 

un-checking the Permit Testing checkbox.  Click the OK button to close the Test Properties 

window. 

 

c- Next, from the test’s summary screen, locate the bad item and change its point value to 

“0”—repeat this action if there is more than one bad item.  Save your changes as you go. 

Changing the point value to “0” will nullify the question and remove it from the test 

calculation.  

 

d- Next, from the Tools menu select Rescore Test.  This action will re-score the test for anyone 

who has already taken it and allow you to re-activate the test if you wish to continue making 

the test available to your testing audience. 
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Best Practice Scenario_2 

You have published your test, we’ll call it test_2.  Only a few members of your testing audience 

have taken the test. You then discover that you have one or a “few” bad items.  We recommend: 

 

a- Either follow the steps outlined in Scenario_1, or 

 

b- De-active the test and use TG Reports to print or export any test_2 test scores before 

deleting them from the test.  This step is entirely optional and really depends on whether you 

want / need to keep the current, pre-correction, test_2 data.   

 

c- Test scores can be deleted by selecting (not opening) the test located under the Courses 

and Tests module.  Click on the test’s Scores tab, select/highlight the results displayed 

under the Scores table and press the delete button on your keyboard or the Delete button at 

the bottom of the Scores table.  

 

Next, your available options include: 

 

1_ Opening the test and editing / correcting the bad item in your test.  Note: if the item was 

imported from a question bank, any (in-test) correction will not automatically correct the bad 

item in the question bank.  It would require you to correct the item twice—once in the test and 

then again in the question bank or you could do an in-test correction and then select and export 

the item back into the question bank—making sure to delete the original bad item from the 

question bank.  We don’t recommend this process, but it is an option. 

 

2- Opening the question bank and correcting the bad item, first.  Then, open test_2, delete the 

bad item and re-import the corrected item from the question bank. 

 

3- Keep the test “shell” but remove and re-import your test items from one or multiple question 

banks—this assumes that you have corrected the original bad item in the question bank before 

taking this step.  From test_2’s summary screen, select the first cell (*) in the first column--this 

will highlight the entire question table.   
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Next, click the keyboard Delete key or the red "x" in the icon toolbar to delete the questions.   

 

 
 

Then, select File > Import > Questions from Question Bank and re-import your test items. 

 

 

 

 

Test Templates  
 
As you master the program, you may settle on a specific set of test behaviors that you would 

like to apply to some / all of your tests.  We’ll refer to our “model” test as test_3.  The following 

process is optional but presented here for your consideration.  

 

1- Create a new course: name it whatever you wish.  In this example, we’ll call it MyTemplates. 

 

2- Next, open our “model” test_3.  By "model" we mean a test that: 

. You have taken / evaluated as a t.taker  

. You have "road-tested" it with your test-taking audience 

. Contains test properties that you would like to replicate in other tests   

 

3- Make a copy of test_3 by selecting File > Save As.  Name it "template-1”, or whatever you 

wish, and save it under the MyTemplates course.  Note: this copy contains the original test 

questions.  Keep in mind that we just want to save the template, not the original test content. 
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4- From template-1’s summary screen, select the first cell (*) in the first column--this will 

highlight the entire question table.   

 

 

 

Next, click your keyboard’s Delete key, or the red "x" toolbar icon to delete the highlighted 

questions.   

 

Important: You will make a copy of template_1 and give it a name—we’ll call it myTest in this 

example.  “myTest” is the test that will be taken by your test-taking audience. 

 

Following steps 1 through 4, myTest does not (yet) contain any questions, but does contain the 

test properties inherited from template_1.  The exception would be randomization settings since 

we have removed all of the questions.   

 

5- Open myTest and select File > Import > Questions from Question Bank and import questions 

from one or multiple question banks into your new test—we assume that you are familiar with 

this process so, we won't go into a lot of detail here. 

 

Important: You have the option of modifying some or all the test properties that were inherited 

from template-1.  For example, you may decide to change the Activation date ranges, Retake 

options and so on.  Whatever you do at this stage will not affect the properties that were defined 

in the original template-1 template described in step 4, above. 

 

You can also create multiple templates containing different test properties.  Whether you create 

one or several templates, we suggest maintaining a text log that describes the properties you 

have defined in each template.  This should help you avoid any confusion later. 

 

6- Once you’ve created a new test from your test template, we recommend reviewing the Best 

Practice: Review before you publish section of this document for further instructions.  
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TG Web: Tester Behaviors 

 

Test Settings >  

Test Properties: General Tab 

 

The only required setting under the General 

tab is the Name of the test.   

 

Best practice: provide your t.takers with a 

test description to avoid confusion.  

 

 
 

If you plan on setting a Pass/Fail percentage, click the 
Settings button under Scoring, and define a Pass/Fail 
percentage, as in this example. 

 

 

 
 

Best Practice  

We recommend assigning question-point values when 

creating or editing questions at the question bank level.   

 

Once you have imported questions into a test, we do not 

recommend changing the point values listed under Total 

Test ___ points.  This value is the sum of all the question 

point values in your test.   
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Example_1 

If your test contains 40 questions, 1 point each, the value displayed in the Total Test points field 

would be 40.  If you were change that value to 100 points, TG would automatically recalculate 

each point value (100/40) to 2.5 points per question—this is allowed but not recommended.  

You can correct or reset the original 1 point per question point value by typing “40” into the Total 

Test points field. 

 

Example_2 

If your test contains 33 questions, 1 point each, the value displayed in the Total Test points field 

would be 33 points.  If you were to change it to 100, TG would automatically recalculate the 

question points. Thirty-two (32) of your questions would have a point value of 3.03 pts (subtotal 

of 96.96) and one question would have a point value of 3.04.  Think of this number as the 

“remainder” point value for your Total Test to equal 100 points.   

 

 

We do not recommend this 

approach especially if you choose 

a test randomization setting that 

randomizes a subset of questions 

from the total set of questions in 

your test – as in the example on 

the right. 

 

 

 

In this randomization example, your test would contain 5 questions randomly selected from a 

set of 33 questions.  Using our 33-question Example_2 above, you run the risk of having some 

t.takers take a test containing five questions at 3.03 points each and some t.takers getting four 

questions with a point value of 3.03 each and one “odd” question with a point value of 3.04.  

This would result in an inconsistency in test-taker scores.    

 

Important Reminder: TG will calculate the correct percentage regardless of the point value 

defined under the Total Test points field.  You can modify these point values during your test 

peer-review/evaluation process; however, once you publish your test, and have actual test-taker 

data, do not change your test’s point values--doing so may corrupt your test results. 
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Test Settings > Test Properties: Schedule > Retakes 

Best Practice:  If you allow more than one retake, and wish to have every test attempt recorded, 

make sure you enable/check the ‘Record score and answers of every attempt’; otherwise, only 

the most recent test record will be stored in TG’s database.  We don’t recommend using this 

setting if you select Unlimited Retakes.  Reason: since each test event is stored in TG’s 

database, you may end up with many superfluous test events which grow the size of your 

database without contributing much in the way of useful information.   

 

 

 

Test Settings > Test Properties: Schedule > Activation, Time Limit, Retakes and Eligibility 

Activation Best Practice: By default, the From and To dates are set to approximately 30 days.  

We recommend extending the To date parameter if you plan on giving the test to multiple users 

throughout the year, or for as long as you wish to keep the test active. 

 

If your test is associated with a course that is only given at certain times of the year, we 

recommend deactivating the test by un-checking the Permit Testing property.   

 

 

 

You can activate and deactivate tests on an as-needed basis. 

 

Time Limit Best Practice: We only recommend using this feature for high-stakes tests or for 

practice tests that need to emulate certification tests that your testing audience will take in 

another venue. 

 

If a t.taker does not complete a test in the allotted time, any items that have not been answered 

will be scored as incorrect. 
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Retakes Best Practice: For high-stakes tests, select the No Retakes option.  For practice tests, 

select the Unlimited retakes option and do not check the Record score and answers of every 

attempt setting.  For all other tests we recommend experimenting with the various retake option 

during the initial peer review evaluation phase. 

 

Eligibility Best Practice:  This feature includes a range of test behaviors, settings and best 

practices that can be found in the Scheduling Tutorial.  This is an advanced feature designed for 

t.authors/t.admins possessing an intermediate to advanced mastery of the TG admin client.  

 

Test Settings > Test Properties: Options > After the Test: Email 

This feature allows t.authors  / admins to compose and deliver email to their t.takers, instructors 

and / or email group.  Note: This feature is only available in TG Web.  See TG Email Tutorial for 

details.  

 

We hope you found this information useful.  Your comments/suggestions are welcome.   

 

Please contact us.    

 

Thank You. 

 

https://www.testshop.com/test-generator-guide-to-test-properties-scheduling
https://www.testshop.com/test-generator-guide-to-using-test-email-test-property
https://www.testshop.com/contact

